
Memory sets

Updating the display in the Radio Memories window from the radio.

Opening a .KTM file into an editable Memory Set window

Loading a Radio's Memory Channels from a Memory Set window.

Reading a Radio's Memory Channels into a Memory Set window

Scrolling through All occupied channels in the Radio windows.



Radio Operation

Selecting a source

Active     Source  

Inactive Sources

Tunable Source

Choosing a Bandspread

Wide

1 MHz

Band

Sub

Setting Frequency and Mode

Coarse     Tuning  

Fine Tuning

Jump: Up/Dn

Mode setting

Hot Spots

Filter Selection ('50-series)

Incremental Tuning (txcvrs)

IT Setting

RIT 

XIT

S-Meter Display ('50-series)

Secondary Meter



Alphabetical List

Active Source

Antenna 1 / Antenna 2 (R-5000)

BandBox

Coarse Tuning

Download command (File menu)

Filter Selection ('50-series)

Fine Tuning

Hot Spots

Inactive Sources

Jump: Up/Dn

Keyboard Tuning

Logging 

Memory sets 

Mode setting

Power (R-5000)

Print command (File menu)

Printer Setup command (File menu)

Radio Operation

Radio Setup command (Options menu)

Reset command (Options menu)

RIT (txcvrs)

S-Meter Display ('50-series)

Save command (File menu)

Save As command (File menu)

Scroll

Secondary Meter  ('50-series)

Set IT  (txcvrs)

Split Operation (txcvrs)
Spread - 1 MHz
Spread - Band
Spread - Sub
Spread - Wide
Timeset button (R-5000)
Transmit (txcvrs)
Tunable Source
Update as Fax command (Options menu)
Update Memories command (Options menu)
Upload command (File menu)



XIT (txcvrs, except TS-140S, TS-50S)



Transmit (Registered Copies Only)

Click the  button to transmit. The transmitter will stay on until you click the button again to return to 
receive mode or turn off the power

Related Topics

Radio Operation

Memory sets 

Split Operation



Split Operation (Registered Copies Only)

Split operation is possible in VFO mode on all supported transceivers.

When you click the  button in VFO mode, the Active vfo becomes the receive vfo and the Inactive vfo 
becomes the transmit vfo. Both are now displayed in the Active panel.

To return to simplex operation, click the Split button again. Until you toggle split off you will not be 
able to select a different source

Split operation is also available in Memory mode as follows:

TS-440S channels 90-99
TS-140S channels 10-19
TS-50/450/850/950S channels 00-89.

When you tune to any of those channels Kentrol will automatically show both its receive and transmit 
settings if they are different.

Related Topics

Radio Operation

Memory sets 

Transmit



Scroll button

Clicking the  button steps the coarse tuning scroll bar upward through its current range, tuning the 
Tunable Source. When it gets to the top of the range, it automatically starts over at the bottom. You can 
change range, band or source while autoscrolling. 

Steps through all filled channels if MEM is tunable, skipping channels that are blank or set to 100 kHz am,
which Kentrol uses as a filler setting.

When scrolling one of the VFOs the tuning step that Kentrol uses depends on the mode, the bandspread, 
and the fine tuning step. If the mode is CW or FSK, Kentrol uses both scroll bars and a step of 500 Hz 
(100 Hz if that is your fine tuning step). For all other modes, only the coarse tuning bar is used, with a 
step of 1 kHz or more. It is more than 1 kHz only at Sub bandspread in the broadcast bands.

Related Topics

Radio Operation



Timeset button(R-5000) (Registered Copies Only)

Clicking the  button when an R-5000 is active opens a dialog which displays the current state of both 
radio clocks, plus system time and UTC. Copy system time to Clock 1 or UTC to Clock 2 by clicking on a 
button.



Antenna 1 / Antenna 2 (R-5000)

Select either of the R-5000's two antenna terminals from the ANT combo box , next to the Mode box. This
setting applies to all three sources and is not saved to memory.



Power button (R-5000) (Registered Copies Only)

The R-5000's on/off switch is remotely controlled by the  button. When the radio is on, the button is 
depressed; when the button is up, the radio is off and all other functions are disabled. When Kentrol 
connects to an R-5000, it automatically switches it on if it is not already.



RIT (txcvrs)

Toggles RIT on and off. This setting applies to all three sources and is not saved to memory.

Related Topics

Coarse Tuning

Fine Tuning

Radio Operation



XIT (txcvrs, except TS-140/680S, TS-50S)

Toggles XIT on and off. This setting applies to all three sources and is not saved to memory.

Related Topics

Coarse Tuning

Fine Tuning

Radio Operation



Set IT (txcvrs)

When RIT or XIT is active (one or both boxes checked) the  button is enabled. When clicked it 
opens the IT setting dialog. in which you can change the offset. This setting is used by both RIT and XIT. 
They can be switched on and off separately, but cannot be set differently.

Related Topics

Coarse Tuning

Fine Tuning

Radio Operation



Spread - Wide

This is the default range.

The Coarse Tuning scroll bar tunes from 100 kHz to 29,999 kHz. Click its end arrows for 1 kHz steps, or 
the bar itself for 10 kHz steps. Jumping up or down (vertical arrow buttons) shifts the frequency by exactly
1 MHz.

Related Topics

Spread - 1 MHz

Spread - Band

Spread - Sub

Coarse Tuning

Fine Tuning

Radio Operation



Spread - Band

If the currently active frequency is within a band that Kentrol knows about, clicking on the Band button 
sets the main scroll bar to the width of the band and labels it appropriately. If you aren't within a 
recognized band, the bandspread defaults to Wide.

Click the end arrows for 1 kHz steps, or bar for 10 kHz steps.

Bands are grouped into services. Kentrol has several services built in:
broadcasting,
amateur,
time signals,
aeronautical (voice only),
marine (voice only)

Jumping goes to the next band up or down in the same service. In amateur and broadcast bands Kentrol 
remembers the last frequency you tuned before you changed bands and automatically restores it when 
you return When you close a radio, last tuned settings are saved and loaded next session.

Related Topics

Spread - 1 MHz

Spread - Sub

Spread - Wide

Coarse Tuning

Fine Tuning

Radio Operation



Spread - Sub

The Sub button gives Kentrol control of mode and tuning step if clicked while you are tuned to a 
frequency within a recognized band. To change modes or tune between steps, click on one of the other 
Spread buttons.

In the Ham, Aero and Marine services Sub also re-sets the main scroll bar to whichever sub-band the 
current frequency falls within. Sub-bands in the ham bands follow US/Can/JA/Region 1 band plans for HF.

Tuning step is 9/10 kHz in the MW broadcast band, 5 kHz in the SW broadcast bands, 3 kHz for Aero 
Route and Marine Phone sub-bands and 1 kHz elsewhere. Clicking on the bar moves 10 steps.

Jumping up or down goes to the next matching sub-band within the current service. Kentrol remembers 
the last frequency you tuned before you changed bands and automatically restores it when you return

Related Topics

Spread - 1 MHz

Spread - Band

Spread - Wide

Coarse Tuning

Fine Tuning

Radio Operation



Spread - 1 MHz

When you click this button, the Coarse Tuning bar's range becomes 1 MHz centred on the current 
frequency. For instance, if you are tuned to 14.260 and select the 1 MHz Spread, the range will be from 
13.760 to 14.760. As in full range click the end arrows for 1 kHz steps, or the bar for 10 kHz steps. 
Clicking the 1 MHz button again re-centers the scroll bar.
Jumping up or down shifts the frequency and the tuning range by exactly 1 MHz, but it does not re-center 
the scroll bar.

Related Topics

Spread - Band

Spread - Sub

Spread - Wide

Coarse Tuning

Fine Tuning

Radio Operation



Jump: Up/Dn

The double-pointed vertical arrow button above the middle of the Coarse Tuning scroll bar allows you to 
jump up and down the radio's frequency range. How jumping works depends on the Spread chosen.

When the Spread is Band or Sub, jumping is within the current service. Jumping up from the highest band
loops to the lowest, and vice versa. Kentrol remembers the last frequency you tuned before you changed 
bands and automatically restores it when you return

When using the Wideband or 1 MHz Spread, the jump is up/down 1 MHz. The 1 MHz range is 
automatically shifted by the same amount.

The Jump button is not available in memory mode.

Related Topics

Radio Operation

Coarse Tuning



Active Source

There are 3 sources: (vfo) A, (vfo) B and M(emory). The Active Source is the one you are listening to. 
Select it with the letter buttons on the Toolbar. The buttons are active when a radio window is on top. The 
split button makes the currently active source the Rx source for split operation. Usually the Active source 
is also the Tunable Source, but it need not be.

Related Topics

Tunable Source

Inactive Sources

Split Operation

Radio Operation



Inactive Sources

There are 3 sources: vfo A, vfo B and Mem. The 2 that you are NOT listening to are the Inactive Sources. 
In the tuner window you can tune an inactive source without making it active. Just click its radio button, 
making it the Tunable Source.

Related Topics

Active Source

Tunable Source

Split Operation

Radio Operation



Tunable Source

There are 3 sources: vfo A, vfo B and Mem. The source with its radio button ON is Tunable. The Tunable 
Source is controlled by the scroll bars in the Tuner Window. By default the Active source is tunable. To 
make another source tunable, click its radio button.

Related Topics

Active Source

Inactive Sources

Split Operation

Radio Operation



 Fine Tuning

The main scroll bar tunes to 1 kHz resolution. The Fine Tuning bar can be set to several steps. The 
default fine tuning step is 10 Hz, with 100 Hz if you click the bar. An ultrafine step of 1 Hz with 10 Hz is 
only available with 50-series radios. Steps of 100 Hz and 500 Hz are handy for tuning narrowband 
modes. The wide steps apply whether you click the arrows or the bar.

When you get to either end of the fine tuning bar and click again, it moves the main (coarse) tuning bar 
one click and resets the fine tuning bar accordingly. This allows you to cover as much of the spectrum as 
you want without having to coarse tune manually.

Fine Tuning is not available when MEM is the tunable source.

Related Topics

Coarse Tuning

Radio Operation



 Keyboard Tuning

Just enter the frequency you want directly into the combo box on the toolbar. When you hit < enter > or 
click the arrow to the right of the box, the rig is instantly set to your selection. Frequency can be entered in
MHz, kHz or Hz, and Kentrol will figure out which is which. You can use as many or few decimal places as
you want, with one exception; frequencies in MHz must be entered with a decimal point, because Kentrol 
assumes that any number below 100 without a decimal point is a memory channel number.

If one of the vfos is active when you enter a frequency, that vfo is tuned to the new frequency. If you enter 
a frequency while Mem is active, the new frequency will be entered into vfo A, which will be made active.

Related Topics

Radio Operation



 Serial Port (Radio Setup dialog)

Use any ports COM1 to COM4, so long as Windows knows where they are.

Related Topics



 Upload command (File menu)

Loads the memory set in the active window into the radio, starting at channel 00 and continuing until the 
radio is full. For most models the last channel is 99, but its 39 in a TS-940S and 30 in the TS-140/680S.

After the file is uploaded, you will want to update the Memories window of your radio by choosing the 
appropriate command on the Options Menu. In most cases this will be Update Memories. But if youve 
uploaded a file of fax mode memories and want to preserve their offset, choose Update as Fax.

Related Topics

Memory sets



 Download command (File menu)

Reads the contents of the radio memories to an open Memory Set Window, then gives it the focus. You 
can then add notes. This command does NOT save to a file; use the Save command.

Related Topics

Memory sets



 Log button

Adds records to a tab-separated ASCII text log file, which you select or create when you configure a 
radio.

UTC date and time, frequency, band and mode , plus signal on 50-series radios, are read directly from the
radio by Kentrol. You are prompted for text, which you can organize into as many or as few fields as you 
want by using '\' as a separator. Kentrol converts the '\' to a TAB, which Windows won't allow you to type in
directly.

Related Topics



BandBox

When you select a service (ham cw, ham phone, ham digital, broadcast, time signal, aero, or marine) 
Kentrol instantly takes you to it, by:

setting the active frequency to the next band (up) of that service;
setting the active mode as appropriate for that frequency;
setting the Spread tuning range to Sub.

From that point you can use the Jump buttons to move to higher or lower bands within that service, use 
the scroll bar to move to another part of the band

Related Topics

Radio Operation



 Region (Radio Setup dialog)

Frequency allocations ('bands') are set by the ITU for 3 world regions:

Region I includes Europe, Africa, Middle East, part of Asia
Region II covers the Americas, plus Hawaii
Region III is most of Asia and the Pacific.

When operating with bandspread set to Band, Kentrol knows the correct bands to use for each Region. If 
you select the USA or Canada you get the Region II bands; select Japan and get Region III bands. If you 
choose Region I, that's what you get. The default is USA.

Compared to the default Region II, Region I has the additional Longwave, 75m and 41m broadcast 
bands, narrower 40m, 80m and 160m ham bands, and 9kHz channel spacing on lw and mw. Region III    
has all of those except longwave. Medium wave spacing in Region II is 10kHz.

It is left to national authorities to decide how the ITU ham bands should be divided into sub-bands. 
Usually these are partly official (e.g. cw/phone) and partly voluntary (e.g. sstv/rtty). In Canada all ham 
sub-bands are voluntary. Kentrol's Sub bandspread provides access to the complete sub-band structures 
for Canada, the USA and Japan. For users in Region I, a generic set of sub-bands is provided.

Kentrol's USA sub-band set largely follows the band plan recommended in the ARRL Operating Manual, 
4th Edition. The Canada set similarly follows the latest version of the RAC suggested band plan for HF. 
Where Kentrol differs from those plans is mostly in designating digital sub-bands. General practice allows 
digital modes more space than the ARRL/RAC plans, so Kentrol reflects general practice.

Your choice is stored in the kentrol.ini file and is used each time the program loads.
Related Topics

Memory sets



 Reset command (Options menu)

If Kentrol gets 'out of touch' with your radio and shows ERR or 0's in the display, choose Reset.
This command causes Kentrol to query the radio twice for settings information as though it had been re-
started, and will usually re-establish the link between computer and radio.

Related Topics

Spread - Sub



Hot Spots

Hot Spots are frequencies that you store temporarily for instant recall. Such short-term storage facilities 
are often called 'scratch' memories; on scanners they are usually called monitor channels. In Kentrol, Hot 
Spots are stored in the combo box on the toolbar.

Type a frequency into the boxs edit control or click the button on the left of the box to automatically store 
the current frequency. The last eight frequencies stored are saved between sessions and reloaded.

To tune to a stored frequency, select it from the combo boxs list. When you click the arrow on the right of 
the box or type <enter>, the radio is automatically tuned to the selected frequency.

Related Topics

Radio Operation

Toolbar



Mode Setting

The edit window of the Mode combo box in the lower left of the tuner window always shows the mode of 
the current active source. Clicking on the arrow beside the box opens the list of possible modes. Select 
the one you want via mouse or keyboard, then click the arrow again to close the list. If you prefer, you can
just type the mode by name into the edit window and the selection will follow your typing.

Fax Mode is a Kentrol exclusive. Select fax as your mode and Kentrol automatically sets the sideband 
and filters and provides the correct (centre tuning) offset. Tune listed frequencies directly.

In FSK mode Kentrol automatically provides the correct (mark tuning) offset, even on 40-series rigs which
display the carrier frequency. FSK mode on the 140/680 and TS-50 is exclusive to Kentrol.

Related Topics

Radio Operation



Filter Selection('50-series)

On all '50-series Kenwood rigs except the TS-50, the IF filters can be selected via the computer, and the 
first (8 MHz) and second (455 kHz) IF filters can be set independently of each other.

The edit windows of the two filter selection combo boxes show the filters currently in use. Changing filters 
is a simple matter of clicking on the appropriate arrow to open its list box, then clicking on your choice.

Related Topics

Radio Operation



Coarse Tuning

The main scroll bar in the tuner window is used for coarse tuning. One step on this scale is 1 kHz or 
more, depending on the bandspread chosen. The current step is shown above the right (high) end of the 
scroll bar. Like all tuner window actions, coarse tuning is applied to the tunable source.

Related Topics

Spread - Wide

Spread - 1 MHz

Spread - Band

Spread - Sub

Fine Tuning

Radio Operation



S-Meter Display ('50-series)

The meter display occupies the upper right of the tuner window when Kentrol operates a 50-series 
transceiver.

While in receive mode the meter shows signal strength on an S-unit scale. In transmit mode the meter 
shows Power in watts.

A secondary meter for transmit only (not on the TS-50S) provides additional information about your out-
going signal.

Related Topics

Secondary Meter  ('50-series)

Radio Operation



Secondary Meter ('50-series)

The secondary meter display and the selected scale are visible only in transmit mode. The choices, 
available from the combo box, are:

a bar indicating the ALC range (for the power meter above), 
bar graph of SWR ratio, 
bar graph of speech compression in dB, and 
no display.

Please note that there will be no reading for Comp unless speech processing is turned on. Also please 
note that SWR reading only works with the built-in antenna tuner switched off. These are hardware 
limitations.

Related Topics

S-Meter Display  ('50-series)

Radio Operation



Kentrol uses extended broadcast bands, based on the current edition of the World Radio-TV Handbook.



The following are built in: WWV/H at 2.5, 5, 10, 15, 20 Mhz and CHU at 3330, 7335, 14670 kHz.



Update Memories command (Options menu)

If the channel contents displayed in the Memories Window do not match the radio because a file has 
been uploaded or some other change made, select this command.

This command causes Kentrol to read the radios memory channels and display them in the Memories 
Window..

Related Topics

Update as Fax



Update as Fax command (Options menu)

When you upload fax mode memories, they are translated into offset USB. If you select the Update 
Memories command the (offset) carrier frequencies will be displayed.

Since there is no way for Kentrol to distinguish them from normal USB channels, you need to select this 
command, which converts everything to fax mode.

Related Topics

Update Memories



Keyboard Shortcuts

TUNING HOT KEYS

In a Tuner window, use the 'c' and 'f' keys to quickly switch between the coarse and fine tuning bars.    
Then you can use the arrow, PgUp/PgDn, Home and End keys to change frequency.Activate the mode 
box with the 'm' key, leave it with Tab to the coarse tuning bar.

The keys below work whenever a radio window - Tuner or Memories - is active

Ctrl + a : select vfo A
Ctrl + b : select vfo B
Ctrl + m : select Mem

Ctrl + h : HOT SPOT (add active freq to Hot Spot List)

Ctrl + l : Log (Log Entry Dialog)

Ctrl + s : toggles SPLIT on/off
Ctrl + t : toggles TRANSMIT on/off

Ctrl + SPACEBAR : toggles AUTOSCROLL on/off

F2 : GOTO next HAM PHONE segment
F3 : GOTO next HAM CW segment
F4 : GOTO next HAM DIGITAL segment
F5 : GOTO next TIME SIGNAL frequency

F7 : GOTO next BROADCAST band
F8 : GOTO next MARINE PHONE segment
F9 : GOTO next MARINE CW segment
F10 : GOTO next MARINE DIGITAL segment
F11 : GOTO next AIRCRAFT band

 NB:    The function keys work even when the BandBox is not visible

Ctrl + u : Jump UP
Ctrl + d : Jump DOWN

SYSTEM HOT KEYS (always available)

F1 : HELP

Ctrl + n : Create a new file (File New Dialog)
Ctrl + o : Open an existing file (File Open Dialog)

EDITING HOT KEYS

These keys work whenever a text window - Memfile or Log - is active

Ctrl + c : Copy Ctrl + z : Undo
Ctrl + x : Cut
Ctrl + v : Paste Ctrl + p : Print





Kentrol Help Topics
How To ...

Operate a radio 
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Index



File menu commands

The File menu offers the following commands:

New Creates a new object.
Open Opens an existing object.
Close Closes an opened object.
Save Saves an opened object using the same file name.
Save As Saves an opened object to a specified file name.
Upload Loads an open memory set into the radio.
Download Reads the current radio memories into an open window.
Print Prints an object. (Registered Copies Only)
Print Preview Displays the object on the screen as it would appear printed.
Page Setup Insert headers and footers.
Printer Setup Selects a printer and printer connection.
Exit Exits Kentrol.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from a document and moves it to the clipboard.
Copy Copies data from a document to the clipboard.
Paste Pastes data from the clipboard into a document.
Paste Link Pastes from the clipboard a link to data in another application.
Links List and edit links to embedded objects.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
BandBox Shows or hides the floating bandbox.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
objects in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Options menu commands

Fine Tuning 
Step

Select 1, 10, 100, 500 Hz fine tuning step.

Radio Setup Set Parameters for the current radio
Update 
Memories

Refresh Memories window from current radio

Update as Fax Refresh Memories, applying fax mode offset
Reset Refresh Tuner window from the current radio



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new object in Kentrol.    That object can be a radio configuration, a memory
set, or a log.Select the type of new file you want to create in the File New dialog box.

You can open an existing object with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

Specify the type of object you wish to create:

Radio creates a new radio configuration object. You will be prompted for the serial port through which it 
will initialize itself.

Memories creates a blank memory set.

Log opens a blank text window. If you then save it as a .LOG file Kentrol can recognize it.



Open command (File menu)

Use this command to open an existing object in a new window.    In the File Open Dialog Kentrol lets you 
choose among object types.    You can open multiple objects at once.    Use the Window 1, 2, ... command
on the Window menu to switch among the multiple open objects.

You can create new objects with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
*.RAD files contain radio configurations. Before you open a *.RAD file, connect the radio.
*.KTM files contain memory sets, usually with notes. You can use a *.ktm file from any radio.
*.LOG files contain loggings saved in pure ASCII database format.

Drives
Select the drive in which Kentrol stores the file that you want to open. 

Directories
Select the directory in which Kentrol stores the file that you want to open.



Close command (File menu)

Use this command to close all windows containing the active object.    Kentrol suggests that you save 
changes to your object before you close it.    If you close an object without saving, you lose all changes 
made since the last time you saved it.    Before closing an untitled object, Kentrol displays the Save As 
dialog box and suggests that you name and save the object.

You can also close an object by using the Close icon on the object's window, as shown below:



Save command (File menu)

Use this command to save the active object to its current name and directory.    When you save an object 
for the first time, Kentrol displays the Save As dialog box so you can name your object.    If you want to 
change the name and directory of an existing object before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active object.    Kentrol displays the Save As dialog box so you 
can name your object.    

To save an object with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save an object with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Kentrol adds the extension you specify in the 
Save File As Type box.

Drives
Select the drive in which you want to store the object.

Directories
Select the directory in which you want to store the object.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four objects you 
closed.    Choose the number that corresponds with the object you want to open.



Exit command (File menu)

Use this command to end your Kentrol session.    You can also use the Close command on the application
Control menu.    Kentrol prompts you to save objects with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    Modify this help 
text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the object and put it on the clipboard.    This
command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Kentrol, such as Source selection, Transmit.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Kentrol,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your application offers. >>

Click To

Open a new object. Kentrol displays the New dialog box, in which you can choose the desired 
object type: Radio, Memory Set or Log.

Open an existing object.    Kentrol displays the Open dialog box, in which you can locate and 
open the desired file.

Save the active object with its current name.    If you have not named the object, Kentrol displays 
the Save As dialog box.

Print the active object. Available for Memory Sets and Logs only.

Remove selected text from the object and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.

Source ButtonsStore Buttons 
Keyboard Tuning
Split (txcvrs) or Time power (R-5000)
Service     Buttons  
Scroll
Scanning Memory     Channels  
Logging
Transmit (txcvrs) or  Power Switch(R-5000)
Hot Spot     Buttons   ('50-series)



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Kentrol window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You can open 
multiple object windows to display different parts or views of an object at the same time.    If you change 
the contents in one window, all other windows containing the same object reflect those changes.    When 
you open a new window, it becomes the active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open object window at the bottom of the main window, then some or all of the icons may not 
be visible because they will be underneath this object window.



1, 2, ... command (Window menu)

Kentrol displays a list of currently open object windows at the bottom of the Window menu.    A check mark
appears in front of the object name of the active window.    Choose an object from this list to make its 
window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Kentrol and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Kentrol.



Context Help command 

Use the Context Help command to obtain help on some portion of Kentrol.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Kentrol window, such as another Toolbar button.    The Help topic will be shown for the 
item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application and object.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Object Control-menu button
Maximize button
Minimize button
Name of the application
Name of the object
Restore button



Scroll bars

Displayed at the right and bottom edges of the object window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the object.    You can use the mouse to scroll to other parts 
of the object.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Kentrol window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges an object window.



Next Window command (object Control menu)

Use this command to switch to the next open object window.    Kentrol determines which window is next 
according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (object Control menu)

Use this command to switch to the previous open object window.    Kentrol determines which window is 
previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single object, the Close command on the object Control 
menu closes only one window at a time.    You can close all windows at once with the Close command on 
the File menu.

Shortcuts
Keys: CTRL+F4 closes an object window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)



Choose Font dialog box



Choose Color dialog box



Find command (Edit menu)



Find dialog box



Replace command (Edit menu)



Replace dialog box



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to 
Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)



Clear All command (Edit menu)



Next Pane



Prev Pane





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document, which may be either a memory set or a log.      This 
command presents a Print dialog box, where you may specify the range of pages to be 
printed, the number of copies, the destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Kentrol is sending output to the printer.
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Printer Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Printer Setup dialog box, where you specify the printer and its connection.



Printer Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

Displays a dialog box where you can choose to include filenames, page numbers and dates 
in either headers or footers on your printed output.






